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spectroscopy products are listed below:

Varian Australia Pty Ltd (Manufacturing site)
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Mulgrave, Victoria 3170
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International telephone: + 61 3 9560 7133
International fax: + 61 3 9560 7950

Varian Instruments

2700 Mitchell Dr
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Internet

The Varian, Inc, Internet home page can be found at;
www.varianinc.com
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e-mail to webmaster@osi.varianinc.com.
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Declaration of Conformity

We hereby declare that the equipment listed below complies with the requirements of:
The Low Voltage Directive 73/23/EEC (93/68/EEC)
The EMC Directive 89/336/EEC (92/31/EEC and 93/68/EEC)

Applicable Standards
LVD  BSEN 61010-1:1993
EMC BSEN 61326:1998 EN 55011:1991 EN 61000-4-2:1995
EN 61000-4-3:1998 EN 61000-4-4:1995 IEC 1000-4-5:1995
IEC 1000-4-6:1996

Equipment Model Number Vista PRO Simultaneous [CP-OES Series

Authorized Representative in the EU

Name: G. A. Wassink Company Name Varian BV
. Address Herculesweg 8

( %(fw[/é 4330 EA Middelburg
Sighed: The Netherlands
Position: Quality Manager Telephone +31 (0) 118 671 000
Date: 1 October 2004 Facsimile +31(0) 118 633 118

Manufacturer
Name: Phil Binns Company Name Varian Australia Pty Ltd
D -Address ' 679 Springvale Road
. ng%-m Mulgrave VIC 3170

Signed: Australia
Position: Director of Operations  Telephone +61 (0) 3 9560 7133
Date: 1 October 2004 Facsimile +61 (0) 3 9560 7950
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Declaration of Conformity

We hereby declare that the equipment listed below complies with the requirements of:
The Low Voltage Directive 73/23/EEC (93/68/EEC)
The EMC Directive 89/336/EEC (92/31/EEC and 93/68/EEC)

Applicable Standards
LvD  BSEN 61010-1:1993
EMC BSENG1326:1598 CISPR 11 EN 61000-4-2:1995
[EC 1000-4-3:1995 EN 61000-4-4:1995 IEC 1000-4-5:1995
IEC 1000-4-6:1996

Equipment Model Number Vista MPX Simultaneous ICP-OES Series

Authorized Representative in the EU

Name: G. A. Wassink Company Name Varian BV
_— Address Herculesweqg 8,
wal,/i 4330 EA Middelburg
Signed: ' The Netherlands
Position: Managing Director Telephone +31 (0) 118 671 000
Date: 1 October 2004 Facsimile +31(0) 118 633 118
Manufacturer
Name: Phil Binns Company Name Varian Australia Pty Ltd
o Address 679 Springvale Road
// o Mulgrave VIC 3170
Signed: 7 ' Australia
Position: Director of Operations  Telephone +61 (0) 3 9560 7133
Date: 1 October 2004 Facsimile +61 (0) 3 9560 7950
)
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Safety practices and
hazards

1.1

Publication date: 04/05

Plasma

Operation of a Vista [nductively Coupled Plasma-Optical Emission
Spectrometer (ICP-QES) involves the use of compressed gases, high
voltage radio frequency energy and hazardous materials including
corrosive fluids and flammable liquids. Careless, improper or unskilled
use of this spectrometer can cause death or serious injury to personnel,
and/or severe damage to equipment and property.

The spectrometer incorporates interlocks and covers which are
designed to prevent inadvertent contact with any potential hazards. If
the instrument is used in any manner not specified by Varian, this
protection may be impaired. It is good practice to develop safe
working habits which do not depend upon the correct operation of the
interlocks for safe operation.

It is essential that no interlock or cover is bypassed, damaged or
removed.

The safety practices described below are provided to help the user
operate the instrument safely. Read each safety topic thoroughly
before attempting to operate the instrument and ALWAYS operate the
spectrometer in accordance with these safety practices.

The plasma is extremely hot (about 10 000 K) and radiates dangerous
levels of radio frequency (RF) and ultraviolet (UV) energy. The work
coil operates at 1 500 V RMS and about 40 MHz. Exposure to the RF
and UV energy can cause severe skin damage and cataracts of the
eyes, while close contact with the operating plasma can result in
severe heat burns to the skin, and an electrical discharge which can
Jump a considerable distance and may cause death, severe electric
shock or sub-surface skin burns.

1-1
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The plasma must NEVER be operated unless:

o the torch compartment door is closed, with the locking lever fully
latched; and

s the space above the chimney is clear of objects.

The shielding around the torch compartment is designed to reduce UV,
visible and RF radiation to safe levels while still permitting easy access
to, as well as installation and viewing of, the torch. The spectrometer
has an interlock system that is designed to extinguish the plasma if
either the mains supply faiis or the handle on the torch compartment
door is opened. DO NOT attempt to bypass the interlock system.

Before opening the torch compartment door, ALWAYS extinguish the
plasma by pressing F4 on the keyboard or by clicking the Plasma Off
icon in the software Toolbar,

The torch and its surroundings remain hot for up to five minutes after
the plasma is extinguished. Touching this area before it has cooled
sufficiently may result in burns. Allow the torch and torch
compartment to cool hefore carrying out any work in this area, or
wear heat resistant gloves.

The plasma system has been carefully designed to operate safely and
effectively when using torches and related components that conform
to Varian's design criteria. Use of non-approved components in the
plasma compartment may render the system inoperative and/or
hazardous. It may also invalidate the warranty on the instrument. Use
only torches and related components supplied or authorized by Varian.

1.2 Heat, vapors and fumes

Heat, ozone, vapors and fumes generated by the plasma can be
hazardous, and must be extracted from the instrument by means of an
exhaust system. Ensure that an exhaust system of the appropriate type
is fitted {as specified in the Pre-installation instructions). The system
must be vented to the outside air in accordance with local regulations
and never within the building. Regularly check the exhaust system by
smoke test to ensure that the exhaust system is functioning correctly.
The exhaust fan must always be switched on BEFORE igniting the
plasma. ‘
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1.3

1.4

Publication date; 04/05

Compressed gas hazards

All compressed gases (other than air) can create a hazard if they leak
into the atmosphere. Even small leaks in gas supply systems can be
dangerous. Any leak (except that of air) can result in an
oxygen-deficient atmosphere which can cause asphyxiation. The area
in which cylinders are stored and the area surrounding the instrument
must be adequately ventilated to prevent such gas accumulations.

Gas cylinders must be stored and handled strictly in accordance with

local safety codes and regulations. Cylinders must be used and stored

only in a vertical position and secured to an immovable structure or a
properly constructed cylinder stand. Move cylinders only by securing

them to a properly constructed trolley.

Use only approved regulator and hose connectors (refer to the gas
supplier’s instructions). Keep gas cylinders cool and properly labelled.
(All cylinders are fitted with a pressure relief device which will rupture
and empty the cylinder if the internal pressure is raised above the safe
limit by excessive temperatures.) Ensure that you have the right
cylinder before connecting it to the instrument.

The primary gas to be used with the spectrometer is argon which is the
conductive gas for the plasma. Argon or nitrogen can be used as the
polychromator purge gas. Other gases may be required for future
options and accessories. Use only ‘instrument grade’ gases with your
spectrometer.

If using cryogenic gases (for example, liquid argon) prevent severe
burns by wearing suitable protective clothing and gloves.

Electrical hazards

The spectrometer system and some accessories contain electrical
circyits, devices and components operating at dangerous voltages,
Contact with these circuits, devices and components can cause death,
serious injury or painful electric shock. Panels or covers which are
retained by screws on the spectrometer and accessories may be opened
ONLY by Varian-trained, Varian-qualified or Varian-approved
customer service representatives (unless specifically specified
otherwise). Consult the manuals or product labels supplied with your
PC, monitor, printer/plotter, water-cooling system to determine which
parts are operator-accessible.

Replace blown fuses with ones of the size and rating shown in the text
near to the fuse holder or in the supporting documentation or online
Help where listed.
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1.5

1.6

Other precautions

Use of the spectrometer system and accessories may involve materials,
solvents and solutions which are flammable, corrosive, toxic or
otherwise hazardous.

Careless, improper or unskilled use of such materials, solvents and
solutions can create explosion hazards, fire hazards, toxicity and other
hazards which can result in death, serious personal injury or damage
to equipment.

Always ensure that laboratory safety practices governing the use,
handling and disposal of hazardous materials are strictly observed.
These safety practices should include wearing appropriate safety
clothing and safety glasses.

Air flow to the cooling fans of the spectrometer and accessories must
be unobstructed. Do not block the ventilation grills on the
spectrometer and accessories, Consult the manuals supplied with your
PC, monitor, printer and water-cooling system for their specific
ventilation requirements.

Great care should be taken when working with glass or quartz parts to
prevent breakage and cuts. This is especially important when attaching
plastic tubing to glass barbs, or removing and replacing pieces of
broken torch or bonnet.

The maximum permissible weight on the sample tray is 5.5 kg (12 1b).

The spectrometer weighs approximately 226 kg (500 Ih). To avoid
injury to personnel or damage to the instrument or property, always
use a forklift or other suitable mechanical lifting device to move the
instrisment.

Use only Varian-supplied spares with your instrument.

Warning and Caution messages

A Warning message is used in the text when failure to observe
instructions or precautions could result in death or injury. The list of
symbols that appear in conjunction with warnings are detailed in
section 1.7.

A Caution message is used when failure to observe instructions could
result in damage to equipment (Varian supplied and/or other
associated equipment).

Publcation date: 04/05
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1.7 Warning symbols

The following is a list of symbols that appear, in conjunction with
warnings, in this manual or on the spectrometer, The hazard they
describe is also shown.

A triangular symbol indicates a warning. The meanings of the symbols

that may appear alongside warnings in the documentation or on the
instrument itself are as follows:

I\

Electrical shock ‘ Eye hazard Noxious gases

Fire hazard Broken glass Corrosive liquids
Heavy weight Heavy weight Hot surface
(danger to feet) (danger to hands)
Cold surface RF radiation

The following symbol may be used on warning labels attached to the
instrument. When you see this symbol you must refer to the relevant
operation or service manual for the correct procedure referred to by
that warning label.

Publication date: D4/0% 1-
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The following symbols appear on the instrument for your information.

| Mains power on

0 Mains power off

-E- Fuse
T

Single phase alternating current

Direct current

indicates that the product complies with the
requirements of one or more EU directives.

‘Out’ position of a bi-stahle push switch.

. |

€ When attached to the rear of the instrument, it
‘In’ position of a bi-stable push switch.

Plasma on

e Plasma off

‘On’ for part of equipment.

‘0Off for part of equipment.

1.8 Color coding

The various indicator lights appearing on Varian instruments and
associated accessories are color coded to represent the status of the
instrument or accessory.

A green light indicates the instrument is in normal/standby mode,
An orange light indicates that a potential hazard is present,
A blue light indicates that operator intervention is required.

A red light warns of danger or an emergency.

Publication date: 0405




Vista series ICP-OES Spectrometers

1.9 US FCC advisory statement

This equipment generates, uses and can radiate radio frequency
energy, and if not installed and operated in accordance with the
imstruction manual may cause interference to radio communications. It
has been tested and found to comply with the limits for a Class A
computing device pursuant to Subpart J of Part 15 of Federal
Communications Commission (FCC) Rules, which are designed to
provide reasonable protection against such interference when operated
in a commercial environment. Operation of this equipment in a
residential area may cause interference, in which case the user will be
required to take whatever measures may be necessary to correct the
interference at his or her expense.

1.10 Spurious and harmonic radiation compliance

Your Varian Inductively Coupled Plasma-Optical Emission
Spectrometer complies with the requirements of FCC rules and
Regulations part 18, subpart H-Miscellaneous Equipment, at the date
of manufacture,

1.11 CE compliance

Your Vista instrument has been designed to comply with the
requirements of the Electromagnetic Compatibility {(EMC) Directive and
the Low Voltage (electrical safety) Directive (commonly referred to as
the LVD) of the European Union. Varian has confirmed that each
product complies with the relevant Directives by testing a prototype
against the prescribed EN (European Norm) standards.

Proof that a product complies with these directives is indicated by:

Q the CE Marking appearing on the rear of the product, and

O the documentation package that accompanies the product
containing a copy of the Declaration of Conformity. The
Declaration of Conformity is the legal declaration by Varian that
the product complies with the directives listed above, and shows
the EN standards to which the product was tested to demonstrate
compliance, It is also signed by Varian’s Authorized Representative
in the EU, and by the representative of the manufacturing plant.

Publication date: 04/05 1-7
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Introduction

2.1

2.2

2.2.1

Publication date: 04/05

Pre-installation requirements

Prior to recefving your instrument you will have been provided with a
Vista Pre-installation manual (PRO publication number 8510164100
MPX publication number 8510184400), that describes the
environmental and operating requirements of the Vista system. You
must prepare your laboratory according to these instructions before
the Vista can be installed. You should keep the Pre-installation
manual for future reference, If you have misplaced your copy, vou can
obtain a free replacement from your local Varian office.

Vista documentation

You have heen provided with the following documentation to help
you set up and operate your Vista system:

0  This operation manual, with Safety practices and hazards
information, instructions for finding information about installing
and maintaining the components of the Vista and a brief
operation overview.

O  An extensive online Help containing context-sensitive Help,
step-by-step instructions for frequently performed operations and
instructions for using any accessories you ordered.

Conventions

The following conventions have been used throughout the
documentation:

O Menu items, menu options and field names (e.g., select Copy
from the Edit menu) have been typed in bold. Bold is also used
to signify the pushbuttons appearing throughout the software
(e.g., click OK).

2-1
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2-2

O ALL CAPITALS indicate keyboard and mouse commands (e.g.,
press the F2 key) and text you must type in from the keyboard
(e.g., type SETUP at the prompt).

U References to “Vista” are applicable to both Vista-PRO and
Vista-MPX unless otherwise stated.

2.2.2 Notes and Hot Tips

A Note is used to give advice or information. A Note is denoted by the
following symbol: =&

A Hot Tip is used to give practical hints to help you achieve the hest
possible performance from your Vista spectrometer. A Hot Tip is
denoted by the following symbol: v

2.3 Specifications

2.3.1 Environmental conditions

The instrument is only suitable for indoor use and is classified suitable
under the following categories (EN 61010-1):

Installation category IT

Pollution degree 2
Safety class 1

Condition Altitude Humid:ity (%RH)
) ' non-condensing

Non-operating | 0-32 050 m 5-45 20-80

(Transport) (0-10 000 f)

Non-operating | sea level 40 90-95

& meeting

dielectric

strength tests

Operating but 0-3 050 m 5-31 <80

not necessarily | {(0-10 000 fi) | 31-35 | <[80-3,33 (temp-31}]

meet_lng ; Where: temp =

specifications . .

temperature in °C

Operating 0-3 050 m 10-35 | 8-80

within (0-10 000 fi)

specifications

Publication date: D4/05
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2.3.2

Publicatior: date: 04/05

Note

For optimum analytical performance, it is recommended that the
ambient temperature of the iaboratory be between 20 and 25 °C and
be held constant to within =2 °C throughout the entire working day.

Electrical power supplies

Note

Note

Power

All power supplies should be single phase AC, 3 wire system (active,
neutral, ground or two active and ground) and should be terminated at
an appropriate connection receptacle that is within reach of the system
power cable,

Spectrometer power connections

Power supply phase | Single
Cable rating 750 VAC, 58 A
Plug supplied Required wall socket
Australia 250 V32 A 250V 32 A
Wilco 56PA332 Wilco 5650332
USA Nema L&-50P Nema L6-50R
Hubbell # 8265 Hubbell # CS8269
Europe Customer supplied Match selected plug
{no plug fitted)

Other electrical connections:
IEEE 488

Basic insulation is provided for single fault protection on the TEEE
connector.

Fuses

1FS1 & 1FS2 Ta.3AH250V, IEC 127 sheet 5, 5 x 20 mm

1CB1 Circuit breaker 30A Fast trip

For safety reasons, any other internal fuse or circuit breaker is not
operator accessible, and should only be replaced by Varian-authorized
personnel.

Fuse information on the rear of the instrument is the most up to date,

2-3
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Electrical requirements

The installation of electrical power supplies must comply with the
rules andfor regulations imposed by the local authorities responsible
for the use of electrical energy in the workplace.

All power supplies for the spectrometer, accessories and water cooler
should be single phase, AC, 3 wire systems (active, neutral, ground or
two active and ground). Each connection should be terminated at an
appropriate receptacle within reach of cach assembly’s power cable.
Use of power boards or extension cables is not recommended.

It is recommended that separate mains circuits, (individually protected
by fuses or circuit breakers) are utilized for each component in the
system such as the water cooler, autosampler and printer.

Avoid using power supplies from a source that may be subject to
electrical interference from other services (such as large electric
motors, elevators, welders and air conditioning units).

Vista spectrometers are supplied with a 2 metres long (6 6"), mains
supply cable. The power cable is hardwired to the rear of the
instrument. The cable is manufactured by Titanex and rated to
750 VAC at 58 amps.

Local regulations in several European countries do not permit the use
of a breakable wall mounted power supply connection for high current
single phase mains supplies. In these arcas, the mains power supply to
the Vista should be hardwired to the wall.

For Canada only, the power cable shipped from the factory must be
replaced with a locally sourced UL/CSA cable such as Carol 02728.

In areas where 208/220/240 volt single phase power supplies are not
commonly available, two active phases from a two or three phase
system may be used.

The instrument supply draws a maximum of 28 Amps RMS at

187 wolts with a power factor of approximately 0.70. In areas where
208 to 240 VAC supplies are not available at the required rating, a
380/415 volt, phase-to-phase, to 220 volt single phase step down
transformer may be installed.

2-4 Tublication date: 04/05
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System unit

Spectrometer

Required supply voltage
208 VAC +100%

220 VAC +10%
provides 230 VAC +6%, -14%

240 VAC £10%
provides 230 VAC +14%, -6%

Frequency 50/60 Hz +1 Hz

Nominal rating

5.1 kVA

Water cooler’
(Typical)

220-240 VAC, 50 Hz
115{230 VAC, 60 Hz
Voltage +10%, Frequency +1 Hz,

2 400 VA
2 100 VA

SPS3 autosampler

96-264 VAC
50-60 +1 Hz

~220 VA

SPS-5 autosampler

100 VAC, +10%
120 VAC, +10%

220 VAC, +10%
provides 230 VAC +6%, -14%

240 VAC, +10%
provides 230 VAC +14%, —-6%

Frequency 49 to 61 Hz

80 VA

VGA-77P

100 VAC, +10%
120 VAC, +10%

220 VAC, +10%
provides 230 VAC +60%, -14%

240 VAC, +10%
provides 230 VAC +14%, 6%

Frequency 49 to 61 Hz

24 VA

Personal computer
(Typical)

115, 120, 220, 240 VAC, 50/60 liz

300 VA

Printer
(Typical)

115, 120, 220, 240 VAC, 50/60 Hz

85 VA

' MPX instruments can be used with water coolers that bave the electrical properties specified here but a non-refrigerated
water cooler of approximately 200 VA is recommended.

Publication date: 04/05
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2.3.3

Gas supplies

The installation of compressed or liquid gas supplies must comply with

the rales and/or regulations imposed by the local authorities
responsible for such use in the workplace.

Liquid or gasecous argon and nitrogen may be used with the Vista
spectrometer systems. Varian recommends the use of liquid gases
which are more pure, more convenient and cheaper per unit volume,

The main gas supply requirement is argon for supply to the plasma,
hebulizer, optics interface purge and camera purge (Vista-PRO only).
Gas is also required to purge the polychromator assembly, and this
may be either argon or nitrogen. On instruments built prior to March
2005, a separate gas line is used that may be connected to either the
argon supply {with the supplied 'T" piece), or connected directly to a
nitrogen supply. For instruments built after March 2005, it will be
connected internally to the argon supply unless the optional nitrogen
purge kit is fitted (either factary or field),

Argon Nitrogen

Purity 99.996% 99.996%

Oxygen <5 ppm <5 ppm

Nitrogen (argon only) | <20 ppm -

Water vapor <4 ppm <4 ppm

Permissible pressure 400-600 kPa

range (57 to 88 psi)

Recommended 550 kPa (80 psi) regulated

pressure -

Required flow rates 0.7-32 L/min 3.5 Limin (if
nitrogen is used to
putge the
polychromator)

The spectrometer is fitted with PTFE gas supply hose assemblies,
1.8 metres (6 feet) in length fitted with Swagelok hardware. Gas
supply adaptors are included with each instrument to connect the
instrument to regulated gas supplies.

Publication date: 0105
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2.3.4

Publication date: 04/05

Storage cylinder instructions

Cylinders containing gas under pressure should be firmly secured to a
rigid structure, and the storage area must be adequately ventilated.

Never locate gas cylinders near a source of ignition, or in a position
that is subject to direct heat. Gas storage cylinders often incorporate a
pressure release device which will discharge the gas at a predetermined
temperature, usually around 52 °C (125 °F).

[f gases are to be plumbed from a remote storage area to the
instrument site, ensure that the local outlets are fitted with stop
valves, pressure gauges and suitable regulators which are easily
accessible to the instrument operator. The gas outlets must be provided
within 1.5 metres (5 feet) of the instrument,

Cryogenic liquids

Cryogenic liquid gases are stored under pressure at very low
temperatures in Portable Liquid Cylinders (PLC).

Warning

Contact with the super-cold liquid, gas or pipe surfaces can cause
severe skin damage. The Portable Liquid Cylinders should be located
in a shielded position, and all piping should be routed or covered to
prevent skin contact.

For high gas flow rates and/or low ambient temperatures, it may be
necessary to obtain the gas by passing the liquid through an external
evaporator rather than use the internal pressure building facility of the
Portable Liquid Cylinders.

Liguid argen and liquid nitrogen may not be stored for extended
periods and often have special storage requirements. Contact your
local authorities and cryogenic gas supplier for more detailed
information on storage requirements and boil-off rates for local types
of Portable Liquid Cylinders.

Water cooling system

Vista instruments require a temperature-controlled source of cooling
water, Refer to you Pre-installation manual for compatible water
cooling systems,

The Varian customer service representative will connect the Vista
instrument to your water cooling system. Connection of the water
cooling system to the spectrometer, installation and adjustment of the
internal pressure regulator and cut-out valve {where fitted) are
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Note

Note

Caution

included as part of the system installation. Installation of the required
power connections and the unpacking of the cooler/recirculator must
be performed prior to installation of the instrument,

The operation manual, mounting and assembly hardware for the
cooling system are included in the water cooler packaging. Care

should be exercised to locate all of these articles before the pack is
discarded.

Cooling capacity Axial system: 1 kW
Radial system: 200 W
Flow rate 1.1 L/min (0.3 gpm) minimum
Recommended inlet 20 °C (68 °F)
temperature (Max. for PRO: 30 °C (86 °F)
(Max. for MPX: 45 °C (113 °F)
Minimum inlet pressure 55 kPa (8.0 psi)
Maximum inlet pressure 310 kPa (45 psi)

Pressure regulation is recommended for supplies where the cooling

water pressure may be subject to fluctuations. Pressure regulation is
necessary for supplies which may exceed the maximum permissible
pressure of 310 kPa (45 psi).

The instrument is equipped with a water flow sensor which will stop
operation of the plasma and camera Peltier assembly if the cooling
water flow through the instrument drops below 1.1 Limin (0.3 gpm).

Always ensure the water cooling system is on before igniting the
plasma,

Provided that the flow rate can be maintained above 1.1 L/min, and
maximum supply pressure is below 310 kPa (45 psi), the cocling water

supply may be taken from an in-house domestic water system, if local
regulations permit,

An alternative is to install a recirculating water cooler system. The
system should provide cover for the reservoir to prevent evaporation

and stop contamination by dust or other impurities, Algaecide should
be used.

A recirculating water cooling system has the advantage of reducing
the volume of water that will be required over the life of the
instrument’s operation. Because of the limited size of the water
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2.3.6
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cooler's reservoir, in the case of accidental damage the amount of
water damage that can occur will also be limited.

Location of water cooling system

Many water coolers are designed to be located and operated indoors.
Consult the water coolar's literature for more information before
installing.

The coolant supply and return hoses of the spectrometer are 3.0 metres
long (10%. The inner diameter of the return hose is 7 mm (1/4"). The
inner diameter of the supply hose is 9.5 mm (3/8"). The supply and
return connection to the water cooling source will require suitable
metal barbs that accommodate these diameter hoses. For most
countries, the appropriate barbs for connecting the instrument to
coolers are included with the instrument in kit form (part number
9910088600).

Drain vessel

The Vista spectrometer system needs a drain vessel for disposal of
excess fluids and vapors from the spraychamber. Suitable tubing is
supplied with the spectrometer for use with inorganic solvents. When
using organic solvents, different drain tubing that is suitable for the
solvent in use will be required.

A chemically inert container, not glass or of a narrow necked style, to
hold a minimum of 2 litres (4 pints) of waste must be provided by the
instrument uset. It should be located underneath the sample
compartment (or on the right hand side of the spectrometer), where it
is protected by the bench and in full view of the operator.

Laboratory conditions

The area selected for the operation of a Vista spectrometer system
must be free from drafts, corrosive atmospheres and vibration.
Sample preparation areas and materials storage facilities should he
located in a separate room.

The area should be a dust free, low humidity environment,
Air-conditioning is strongly recommended for control of the
environment. For optimum analytical performance it is recommended
that the ambient temperature of the laboratory be between 20 and

25 °C.
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Note

Temperature contreol

The heat generated by the Vista system into the laboratory is about
3 650 watts, (joules per second) or 13 140 kilojoules per hour
(12 455 BTU per hour).

Most of the 3 650 watts generated by the system is vented outside the
laboratory by the exhaust systern.

The water cooler generates up to 1 000 watts, (joules per second} or
3 600 kilojoules per hour (3 412 BTU per hour).

Total load with both the water cooler and spectrometer in the same
room would be up to 4 650 watts or 16 740 kilojoules per hour
(15 867 BTU per hour).

2.3.7 Cleanliness

2.3.8

Note

Limit dust levels to less than 36 000 000 particles (0.5 microns or
larger) per cubic metre of air.

Instrument cooling air supply

The spectrometer requires clean, dry, non-corresive air for cooling
purposes. This is supplied to the instrument through an air supply
vent located at the top, rear of the instrument. The vent has been fitted
with a dust filter, to filter out particulate matter from the surrounding
environment,

The air supply is used to cool the RF generator and the electronics of
the instrument. Several of these assemblies contain parts prone to
corrosion. The inireduction of cooling air contaminated with high
levels of acid, vapors or other corrosive substances may cause damage
to the instrument.

Due to the corrosive nature of some analytical work, it is
recommended that in applications demanding high usage of corrosive
materials, an external cooling air supply system is provided. It is
strongly recommended that the cooling air be supplied from an
environmentally controlled area that is away from the instrument
exhaust and arly other area where corrosive materials are stored or
used.

The cooling air system with flue, fan, ducting and supply cowl, must
provide a minimum positive flow of & cubic metres per minute
(200 cfm). The ducting should be corrosion resistant and fire-proof.

If an external cooling air supply system is required, an air inlet duct
attachment (part number 0110595300) must be ordered with the
instrument,
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2.4 Weights and dimensions

System unit Width Depth Height Weight

Vista 1375 mm 720 mm 992 mm 226 kg
54.5" 28.5" 39" 500 1b

Shipping dimensions 1 660 mm 960 mm 1420 mm 325 kg
65.5" 37.8" 56" 716,51b

Personal computer

IBM compatible 450 mm 770 mm 520 mm (n/a)

(typical) 18" 30" 20" (nfa)

Printer

Taser jet 500 mm 650 mm 200 mm (nfa)

(typical) 18" . 30" 20" (nfa)

‘Water cooling system

Lytron MCS-20 GO3 and 439 mm 384 mm 338 mm 15 kg

Lytron MDC-20 HO3 17.3" 15.1" 13.3" 331k

Van der Heijden Typ 350 mm 405 mm 505 mm 42 kg

001VD for ICP and

Van der Hefjden Typ 13.8" 15.9" 19.9" 93 Ib

Minore IIVD

Neslab CFT 33 375 mm 560 mm 6272 mm 72.6 kg
14.8" 22" 245" 160 1b

Neslab M-33 321 mm 511 mm 606 mm 68 kg
13", 20.1" 23.9" 150 1b

Affinity RAA-003-0CB 483 mm 687 mm 457 mm 80 kg
19" 27" 18" 175 1b

Continued...
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System unit

SPS3 490 mm 285 mm 510 mm 15 kg
19.3" 11.2" 20.1" 33.11b

Shipping dimensions 760 mm 500 mm 840 mm 31 kg
29.9" 19.7" 33.1" 68.4 1b

SPS3 with diluter 572 mm 285 mm 510 mm 18 kg
22.5" 11.2" 20.1" 39.7 b

Shipping dimensions 760 mm 500 mm 840 mm 34 kg
29.9" 19.7% 33.1" 75,1 1b

SPS trolley 580 mm 412 mam 400 mm
23" 17" 16"

SPS-5 525 mm 610 mm 570 mm 19 kg
21" 24" 23" 42 1b

Shipping dimensions 580 mm 670 mm 660 mm 35 kg
23" 26" 26" 77 1b

SP5-5 diluter 160 mm 80 mm 410 mm ' 3 kg
21" 7" 22" 71b

Shipping dimensions 300 mm 180 mm 570 mm 5 kg
6" 3" 16" 111b

VGA-77P 250 mm 200 mm 220 mm 5.5 kg
10" 8" q" 12 1b

Shipping dimensions 385 mm 340 mm 400 mm 8.5 kg
15" 14" 16" 19 Ib

AGM1 550 mm 430 mm 245 mm

Shipping dimensions 22" 17" 9.5"

Ultrasonic Nebulizer 780 mm 540 mm 1150 mm

(trolley mounted)
31" 21" 45"
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2.4.1 Moving the Vista instrument

Warning
The spectrometer weighs approximately 226 kg (500 Ib). To avoid

injury to personnel or damage to equipment, always use a fork lift
or other suitable lifting device when moving the instrument,
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Installation

3.1

Publicafion date: 04/0%

The Vista instrument must be installed by a Varian-trained,
Varian-qualified or Varian-authorized customer service representative,

You should have completed and returned the form in the Vista
pre-installation manual stating that you have prepared the laboratory
in accordance with the requirements detailed in that manual. A Varian
representative will then arrange a suitable installation date with you.

Details for unpacking the instrument and what to do in case it has
been damaged in transit are also detailed in the Vista Pre-installation
manual.

PC requirements

The recommended and minimum PC specifications are listed in the
Vista specifications brochure {PRO publication number 8710166200,
MPX publication number 8710185300). They can also be found on
Varian's website at www.varianinc.com. The minimum configuration
represents the absolute minimum that is required to run the software.
This PC configuration may be cut of manufacture, but you may want
to use a PC you already have. The recommended configuration should
be followed when buying a new PC.

3-1
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3-2

3.1.1

To operate the instrument using the ICP Expert software, you must
have completed the following:

Step

Non-21 CFR 11 software:
Installed either Windows®
2000 operating system
with Service Pack 4 {or
later), or Windows® XP
operating system with
Service Pack 1 (or later);
and checked that all
devices (e.g., sound card,
CD-ROM) are working,

Instructions to follow
Refer to the documentation supplied
with your operating system software.

21 CFR 11 software:
Installed either Windows
NT® operating system
with Service Pack 6, or
Windows® 2000
operating system with
Service Pack 2 and
checked that all devices
(e.g., sound card,
CD-ROM) are working.

Refer to the documentation supplied
with your operating system software.

Installed the ICP Expert
software and the Help
(second CD).

Refer to section 3.1,1.

Installed the GPIB drivers,
GPIB card and cable
connecting the Vista to
the PC.

Refer to section 3.1.2 (version 4.x
software).or 3.1.3 (21 CFR 11
software) and 3.1.4.

Re-booted the PC.

Refer to your operating system
documentation.

Installing the ICP Expert software

Although the Varian-trained, Varian-qualified or Varian-authorized
customer service representative will install the ICP Expert software for
you during the installation process, you may need to install the
software yourself at some later stage, for example if you change the

PC.
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To install the ICP Expert software:

1. Insert the ICP Expert software CD in your CD-ROM drive, The
software will automatically start',

2. Follow the instructions appearing on the screen. During the
installation you will be asked to specify, amongst other things,
the drive on which to install the software.

When the installation is complete you should have an ICP Expert

program group on the desktop containing a number of icons. The

installation also places an ICP Expert folder in the Start » Programs
menu.

- Note If you are running Windows NT® and do not have Administrator
privileges, the installation will fail, To successfully complete the
installation, log on as an Administrator and start the instaliation
process again.

3. Remove the ICP Expert software CD from the CD-ROM drive and
insert the ICP Expert Help and Videos CD, as prompted.

4,  After successful installation of the software, shut down the PC
and install the National Instruments PCI-GPIB card into the PCI
slot. Refer to section 3.1.4 for instructions on how to do this.

- Note  For version 4.x software, when installing the ICP Expert software for
the first time, it is very important to install the PCI-GPIB card driver
BEFORE plugging the PCI-GPIB card into the slot. The driver is
autematically installed during ICP Expert installation, so do not plug
the PCI-GI'IB card into the slot before installing the ICP Expert
software.

Peled Hot Tip  To familiarize yourself with the ICP Expert software, you should now
click the Windows Start button and choose Programs » ICP Expert »
ICP Expert Help. When the ICP Expert Help appears, click the How to
link to view step-by-step instructions on how to use the Vista
instrument and software.

Y1 you have turned off the auto-start capability of your CI-ROM drive you will need to run the setup,exe file on the
CD-ROM.
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3.1.2 PCI-GPIB driver instailation (version 4.x software)

Once you have installed the ICP Expert software then plugged in the
PCI-GPIB card (see section 3.1.1);

1. Turn on the PC. A message will appear alerting you that the
system has found the PCI-GPIB card.

2. Follow the prompts and restart your PC for the GPIB driver
installation to be completed.

When upgrading from a prévious version of ICP Expert where the

GPIB driver and GPIB card are already installed, you only need to

update the GPIB driver. This update will occur automatically during

ICP Expert software installation.

Refer to the Release Notes (Release Notes.txt) for fufther information.

3.1.3 PCI-GPIB driver installation (21 CFR 11 software)

Note

For all Windows® operating systems except Windows NT® 4, the
installation of the PCI-GPIB driver occurs automatically during
software installation. After installing the software, you only need to
install the PCI-GPIB card (refer to section 3.1.4) to complete setting up
the GPIB.

For Windows NT® 4, the PCI-GPIB driver is also installed
automatically during software installation, however it needs to be
configured.

Although the Varian-trained, Varian-qualified or Varian-authorized
customer service representative will configure the PCI-GPIB driver for
you during the installation process, you may need to configure the
driver yoursell at some later stage, for example if you change the PC,

You will be prompted to configure the driver at the end of the
installation, by a dialog box as follows:

f
|

s s el s s e b e R R 3
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3.1.4
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If you have a PCI-GPIB card in your computer;

1. Click Yes. The following screen will be displayed.
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2. Follow the instructions in the Notepad window displayed
(GPIB_Install.txt) to complete the installation.

If you do not have a PCI-GPIB card in your computer:
1. Click No.

2. Once you have installed the PCI-GPIB communications card, (refer
1o section 3.1.4 for details), you can configure the PCI-GPIB card at
any time. To do this, click the Windows® Start button and choose
Programs » ICP Expert » Config GPIB_P(], then follow the
prompts.

PCI-GPIB communications card installation

Note

Caution

The National Instruments PCI-GPIB card {part number 9910102100)
must be installed in your PC to interface the PC and Vista
spectrometer.

Although the Varian-trained, Varian-qualified or Varian-authorized
customer service representative will install the GPIB communications
card for you during the installation process, you may need to
configure the driver yourself at some later stage, for example if you
change the PC,

The components on the communications card and in the PC are
highly static-sensitive. To avoid damaging these components you
must drain any static charges from your body before installing the
board, and prevent the generation of any new static charges during
the installation.

This can be done by wearing an ESD (electrostatic discharge) wrist
strap attached to a grounding point. You can obtain a disposable




Vista series ICP-QES Spectrometers

ESD strap from Varian (part number 791003 1300); or you can
obtain one from your local electronics supplier.

To install a National Instruments PCI-GPIB communications card: ;

1. Tuarn off and unplug the computer.

2. Remove the cover, following the instructions in the manual
provided with the computer.

3.  Attach one end of the ESD strap to a bare metal part of the PC
chassis and wrap the other end around your wrist.
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Remove a blanking plate from one of the empty slots in the computer.

%

4. Remove the card from its static-shielded packaging. Do not touch the
gold edge connectors,

Publcalion date; 04/05 ’ . 3-7



Vista series ICP-QES Spectrometers

6.  Press the card firmly into the empty PC slot. The gold edge connectors
should slide firmly into the matching sockets of the PC slot. Secure the
card with the screw.

3-8 Publication date; 04/05

[a—



Vista series ICP-OES Spectrometers

8. Connect the cable between the Instrument and the computer (one end
plugs into the interface board in the computer, and the other plugs
into the socket in the rear of the instrument),

9. Connect the computer to the mains power,

10. Turn the computer on.

3.2 Hardware installation

Your Vista instrument should be ready to operate after the Varian
customer service representative has installed it. However, you may
need to change items such as the nebulizer, torch or spraychamber.
For instructions on how to do this, please refer to the online Help.
Specifically:

1. Click the Windows Start button and choose Programs » ICP
Expert » ICP Expert Help.

2, When the ICP Expert Help software appears, click the Hardware
link to view step-by-step instructions (including videos) on how
to remove and install the various instrument componenis.
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Operation

4.1

4,2
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You will find step-by-step instructions for common operations in the
iCP Expert online Help. To access this information:

L.

Select the Windows Start button and choose Programs » ICP
Expert » ICP Expert Help.

When the ICP Expert Help appears, click the How to link to view
the available step-by-step instructions.

Below is a quick guide to getting the instrument set up and running
samples.

Analysis checklist

You need to complete the following steps in turn to measure a
sample(s). You will find details on each step in this chapter.

a

a
]
a

Turn on the instrument and software
Calibrate the detector

Align the torch

Develop a method

O  Check for potential interferences
o Set operating conditions

O  Set up standards

Run samples

Print a report

Turning on the instrument and software

Before starting the system, carefully read the Safety practices and
hazards section at the front of this manual and ensure that the
laboratory is set up according to the details specified in the Vista
Pre-installation guide.
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4.2.1 Turning on the instrument for the first time {or from
Shutdown mode)

1. Check that all tubing on the torch, spraychamber, nebulizer and
peristaltic pump is correctly connected.

2. Close the torch compartment door, ensuring that the locking
lever is fully latched.

3. Switch on the computer, monitor and printer.
4.  Switch on the water cooler.
5. Tumn on the gas supply at the cylinder.

6. Plug the cable into the wall socket and set the switch to ‘on’,

7. To turn on the spectrometer, set the RF supply circuit breaker
located on the rear right-hand side of the instrument to the ‘on’
(up) position.

.;|,j

Fuses and RF circuit breaker
1. Fuse
2. RF circuit breaker

8, Set the instrument power switch, located at the front left of the
instrument, to ‘I’ (the green power indicator should Light).

ot Note Both the RF supply circuit breaker and instrument power switch must
be switched on for the instrument to work,

9. Switch on the laboratory exhaust system,
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Warning
The plasma emits heat, ozone and fumes which can be hazardous.
Always switch on the exhaust system before lighting the plasma.

10. 'To start the ICP Expert software, click the Windows Start button
and then choose Programs » ICP Expert » ICP Expert. The
Main Index window will appear.

4,2.2 Turning on the instrument from Standby mode

1. Check that all tubing on the torch, spraychamber, nebulizer and
peristaltic pump is correctly connected. ‘

2. Close the torch compartment door, ensuring that the locking
lever is fully latched.

3. Switch on the monitor and printer (if off).
4.  Switch on the water cooler (if off).

5. Switch on the Peltier (if it was set to off) by choosing Peltier on
from the Analyze menu.

o " Note You can check if the Peltier is on by locking at the Instrument Setup
window Status page. It may take some time to reach operating
temperature. It is recommended that you wait three to five minutes
before starting an analysis.

6. If you have accessories fitted, switch them on.

7. Switch on the laboratory exhaust system.

Warning
' The plasma emits heat, ozone and fumes which can be hazardous.

Always switch on the exhaust system before lighting the plasma,
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4.3 Preparing for analysis

Note

Note

1. Place the sample tubing from the peristaltic pump into the wash
solution and the drain tubing into the drainage vessel.

2. Turn on the plasma by clicking the Plasma On or by pressing the
SHIFT+F4 keys on the keyboard. The pump will be initialized and
the solution will begin aspirating,

The plasma will take beiween 30 to 40 seconds to ignite. If it fails to
ignite, refer to the Troubleshooting section in the online Help for
further information,

3. Adjust the pressure bars on the peristaltic pump for even sample
flow if you have not already done so.

See the online Help for instructions on how to adjust the pressure
bars.

4.3.1 Wavelength calibration

Note

Refer to the online help for information about what a wavelength
calibration is, and how to prepare the wavelength calibration solution,

To perform a wavelength calibration:

4. Check that the Polychromator Boost purge is on. To do this, click
the Instrument Setup icon on the Main toolbar to bring up the
Instrument Setup window. Click the Status tab and check that
under the Polychromator listing Poly Boost is 'On’. If the Poly
Boost purge is "Off" you should turn it on. To do this, choose Poly
Boost On from the Analyze menu in the main window, Reopen
the Instrument Setup window. Under Polychromator, Poly Boost
should now say 'On’. Leave the poly boost purging for at least 20
minutes prior to performing the wavelength calibration.

It is highly recommended that the Poly Boost purge is on when
performing a wavelength calibration. If you do not intend to measure
wavelengths under 190 nm, you may wish to turn the Poly Boost
putge off. To do this, choose Poly Boost Off from the Analyze menu
in the main window. Note that the calibration may not cover the
entire wavelength range, or may fail if the Poly Boost is not on.

5. Open the Instrument Setup window (if it is not already open), by
clicking the Instrument Setup icon on the Main toolbar, and click
the W/L Calib tab.
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With the wash solution aspirating, click Calibrate Detector. It will
take roughly 1 to 2 minutes to calibrate the detector, Once
completed, a message will appear indicating the dark current
measurement has heen completed.

Note  You can save the dark current measurement data by clicking Store
Detector Calib.

7.

Remove the sample tubing from the wash solution. Wipe the
tubing and transfer it into the wavelength calibration solution.

Once the wavelength calibration solution is aspirating, click
Calibrate Wavelength to perform the wavelength calibration.
After a short while, a message will appear stating that the
wavelength calibration is complete, as well as indicating the
wavelength calibration range,

Note By defauli a wavelength calibration uses the
' Wavelength Calibration .vws (Vista-PRO) or Wavelength
Calibration.sws (Vista-MPX) worksheet.

9.

10.

If the calibration fails prepare a new wavelength calibration
solution and try again, or consult the Troubleshooting section of
the help.

(Vista-MPX only) Perform a hardware calibration. To do this,
ensure that the wavelength calibration solution is aspirating, and
click Calibrate Hardware. A dialog box will appear once the
calibration has been completed,

Note  Preferably, this step should be performed by a Varian customer
support representative.

Torch alignment

You now need to align the torch before using a new method. To do
this:

11.
12,

13.
14,

Place the sample pump tubing into a 5 ppm Mn solution.

From the Main Index window of the ICP Expert software, choose
Instrument Setup from the Window menu. The Instrument Setup
window is displayed.

Click the Torch Align tab,

Ensure that the Scan Method path points to the
TorchAlignment.vws file (Vista-PRO) or TorchAlignment.sws (for
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Vista-MPX). The file is located in the \Program
Files\Varian\ICPExpert\Supplied Worksheets directory on the drive
the ICP Expert software is instailed.

The TorchAlignment file consists of a single line, Mn 257.610 nm,
which is recommended because it gives a representative viewing
range scan for mosi analytical lines.

15, If the TorchAlignment file is not listed in the Scan Method path,
click the Browse button and choose the file from the Load Method
dialog box.

16. Perform a horizontal scan by clicking the Torch Sean button on
the Torch Align page.

17. If you have an axial unit, perform a vertical torch scan after you
have performed the horizontal scan, When the instrument scans
the torch, it will move the pre-optics to the optimum positions for
viewing the plasma. The optimum positions are displayed on the
sHde-bars. If the horizontal or vertical positions have changed by
more than +1 from the previous setting, perform another
horizontal scan.

When you perform a torch alignment scan, you should expect to see a
scan result similar to the following:

An ideal torch alignment scan
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4.4

4.4.1
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Developing a method

L.

From the Main Index window, click the Worksheet button, The
Load Worksheet dialog box will be opened.

Click New in the Load Worksheet dialog box. The New Worksheet
dialog box is displayed.

In the New Worksheet dialog box (ICP Expert version 3 or higher:
on the New page), enter a name for the worksheet. This will be the
name that the worksheet is ultimately saved as.

Click Save. The Worksheet window will appear with the new
worksheet loaded.

Open the Method Editor by clicking the Method Editor icon on the
Toolbar. The Element page of the Method Editor will be displayed.
The editor consists of a series of pages that allow you to develop
the method.,

On the Element page, ensure that the Periodic Table is displayed.
If it is not visible, choose Periodic Table from the View menu.

Select the required elements by clicking on each element in the
Periodic Table. This will display the Add Analysis Line dialog box,
which shows thing such as wavelengths, internal standards and
potential interferences.

Note You can also add multiple elements by holding down the CONTROL
key and clicking the required elements in the Periodic Table. The most
prominent line will be automatically added to the method as an
analyte,

Selected analytes will be highlighted in blue.

Checking for potential interferences

8.

In the Add Analysis Line dialog box under Potential Interferences,
check that there are no interferent or other analytical lines close to
the selected analytical line. Their relative intensity will govern
how close the lines can be to each other. For example, if your
matrix contains an element that is not of analytical interest, but is
a potential interferent that has a low intensity line close to one of
your analytical lines, the concentration of that element in your
matrix will determine whether you need to choose another
analytical line. Click OK once you have made any required
adjustments in the Add Analysis Line dialog hox.
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Note

Note

Note

9. Repeat steps 7 and B to add additional elements.

If you are unable to select a line that is free of interferences, you can
use the FACT (Fast Automated Curve-fitting Technique) or
Inter-Element Corrections (IEC) facilities of the software. Refer to the
online Help for more details.

Physical interferences arise from solutions having different viscosities
and surface tensions. This produces variable nebulization rates and
alters conditions in the plasma. This situation is best corrected by
matching the blank and standards to the sample matrix and sample
solvent.

Changes in the peristaltic pump tubing with usage can also be a
source of physical interference, This is best corrected with Internal
Standards. You may have to use either several internal standards
and/or several analytical lines for specific internal standards in order
to match as closely as possible the behavior of the different analyte
lines.

Setting operating conditions

11. Once you have finished selecting the analytical lines, click the
Conditions tab.

12, Ensure that All Lines Share Same Conditions is selected in the
Options menu. Click the Multiple Graphs icon from the graphics
window so that multiple graphs can be viewed at once.

13. Remove the sample tubing from the wash solution. Wipe the
tubing and transfer it into the solution to be analyzed. Once the
solution is aspirating, click the Read Spectrum icon to petform a
scan.

14, When the scan is complete, you may alter the settings for the
selected line, and perform another wavelength scan to compare
the effects of different operating conditions on the analytical
signal. This will allow you to determine the optimum settings for
the selected line. Ensure that Overlay is selected in the Graphics
menu so that you can compare the signals.

The AutoMax feature (Vista-PRO only) of the software will
automatically set operating conditions for each line, Refer to the
online Help for further details.
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Caution

Note

High plasma operating powers can result in torch meltdown. When
running the torch at a power setting above 1.4 XW, always monitor
the torch and decrease the power if it starts to overheat,

Plasma gas flows that are too low may also cause the torch to
overheat and melt.

Recommended values for the line settings are given in the Conditions
used by, Sample introduction and General settings online Help pages.
Use these values as a guide when entering your own values until you
become more familiar with the system.

15. Repeat the above steps until YOu are satisfied with your results.
Generally, this involves finding the optimum intensity.

Setting up standards

Note

16. Click the Standards tab to display the Standards page. Ensure the
Calibration mode is Quantitative, not Standard Additions.

17. Enter the number of calibration standards required. As you add
standards, columns will be added to the Standard concentrations
table.

18. Enter the concentration of each standard in the table.

19. Select the units required by clicking on the required cell and
choosing the units from the drop-down menu.

Leave the Correlation coefficient at its default value of 0.995000. The
MultiCal parameters table can remain unchanged.

Chicking on the element name in the Standard concentrations table
will highlight the row. If your standards have the same values, you
can quickly copy and paste the row values by right-clicking on the
table and using the Copy and Paste options.

20. Click the Notes tab to add any additional information regarding
the method, sample preparation, calibration preparation, the
matrix, user information or any other general information
required. The Notes page is a simple text editor.

21, Choose Exit from the File menu to close the Method Editor. Click
Yes when you are prompted to save your changes.
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You can now run an analysis using the method you have just
developed.

4.5 Running samples

L Note

4-10

1.

9.

From the Worksheet window, click the Sequence tab and do the
following:

Ensure the Sample source is set to Manual.

Click the Sequence Editor button, Enter the required number of
samples in the Sample count field.

Select Begin with calibration and Include a blank in calibration.
Select the other boxes as required.

Click OK. You will be prompted to confirm your selections.
From the Sequence page, click the Sequence Parameters button.

Set On calibration failure to Stop.

Click OK to exit. When you are asked to confirm your selections,
click Yes.

Click the Analysis tab and do the following:

Ensure your samples are selected. This will be indicated hy a yellow
highlight. To select all solutions, click the Tube cell in the top left
corner of the table.

(lick the Start Analysis icon in the Toolbar to begin the analysis and
follow the subsequent prompts,

If the Start icon is grayed out, hold the cursor over the icon until the
hint text (enabled in the View menu) is revealed. This will indicate
what action is required to enable the icon.

The Start icon will only be available under the following

circumstances:

Q the torch is on;

O  the Peltier has cooled down and has stabilized;
QO  at least one worksheet is open;
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solutions are selected for analysis;
the Analysis page is open;

a wotksheet is not currently being run;

O O D C

the autosampler is online, if an autosampler sequence is selected.

Printing a report

Note

Note

1. From the File menu, choose Report Settings.

When printing a report, you can simply select Print from the File
menu. However, if you do so, a report will be generated based only
upon the last used Report Settings. You will not be able to select the
data to be included in the print out.

2. In the Report Settings dialog box {ICP Expert version 3 or higher:
on the General page), specify the following:

O whether to generate a native or HTML report (ICP Expert
version 3 or higher);

the report style;

whether to report all of the results or only those highlighted;
the data content to be included;

what calibration data is to be included;

include a match sample label string, if required; and

O OO Cc O O

the appearance of the report, including whether you want to
print the report in color, and the size of the graphs (ICP
Expert version 3 or higher: This is done on the Customize
page. A header, footer and logo can also be added on this
page.)

When selecting the report style, please note the following:

Tabular produces a report in the same form as the worksheet.
Calibration data cannot be selected for printing.

Mean Only reports are designed for analysts who are only interested
in final results. As a result, many of the Content options and the
option to print Calibration data are disabled.

An All Data report allows you to select all of the Report Settings
options to include in your report.
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4.7

4.7.1

Note

You can preview the report if required by clicking the Preview button.
Previewing the report allows you to ensure that you have included all
of the data you require.

3. Click the Print bution to generate a report as specified. A message
will appear briefly indicating the progress status of the report
being generated.

4. The Print dialog box will then be opened. You can select to print
all of the report, or a range of pages. Reports are printed to your
default printer, unless you specify otherwise. You can specify
your printer options in the Print Setup dialog box, accessible
from the File menu.

As the Print dialog box is a standard Windows® dialog box, you can
obtain “What's this” Help on an item by clicking the question mark
icon in the top right corner and then clicking the item of interest,

Turning the instrument off

There are two modes of turning off your Vista instrument. For
day-te-day use, it is recommended that the instrument be set to
Standby mode (which keeps the polychromator thermostating system
and purge systems operational). When the Vista is not going to be in
use for prolonged periods, the Shutdown mode may be used (which
turns off all purging as well as the polychromator thermostating
system).

Using standby mode

Note

Note

To set the instrument to Standby mode:

1. Rinse the spraychamber by aspirating water for a few minutes.

When running organic samples it is recommended that the
spraychamber be cleaned and dried thoroughly between analyses.

2. Extinguish the plasma by clicking the Plasma Off icon, pressing
T4 on the keyboard or choosing Plasma Off from the Analyze
menu. The peristaltic pump stops automatically when the plasma
is extinguished.

The yellow Plasma Emergency Off button, located next to the mains
power switch on the front of the instrument, is designed to be used
only in an emergency—for example if the torch is melting. It is not
intended to be used every time you want to extinguish the plasma.
If used to extinguish the plasma, you will need to reset the Plasma
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Note

Emergency Off button to the 'on’ position before the plasma can be
re-ignited.

3.

6.

Leave the mains power switch on to keep the polychromator
thermostating system operational.

To save on argon costs, it is recommended to turn the
polychromator boost off avernight, by choosing PolyBoost Off
from the Analyze menu.

To increase the pump tubing lifetime, loosen the peristaltic pump
tubes by releasing the pressure bars and lift the tubes out of the
grooves. To do this:

(a) Unclip the pressure bar screws leaving the pressure bars
resting loosely against the rollers.

(b) Lift the tubing out of the grooves so that they are not being
stretched over the rollers.

You may switch off the water cooler if you wish,

If the water cooler is turned off, the Peltier will automatically turn off.

7.

For Vista-PRO instruments in particular, if you would like
immediate operation next time the instrument is started, leave the
computer and gas on to eliminate the need to purge the detector.
Close the worksheet by selecting Close from the File menu but
leave the ICP Expert software running, You may switch off the
printer, monitor and any accessories if desired. Ensure that the
powersave option on your PC is disabled.

Warning
The exhaust system MUST remain on if the gas supplies are on.

Using Shutdown mode

Note

To Shutdown your instrument:
1.

Rinse the spraychamber by aspirating water for a few minutes.

When running organic samples it may be necessary to disconnect the
spraychamber and clean and dry it thoroughly between analyses.

2.

Extinguish the plasma by clicking the Plasma Off icon, pressing
F4 on the keyboard or choosing Plasma Off from the Analyze
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Note

Caution

Caution

menu. The peristaltic pump stops automatically when the plasma
is extinguished.

The vellow Plasma Emergency Off button, located next to the mains
power switch on the front of the instrument, is designed to be used
only in an emergency—for example if the torch is melting. It is not
intended to be used every time you want to extinguish the plasma.
If used to extinguish the plasma, you will need to reset the Plasma
Emergency Off button to the 'on’ position before the plasma can be
re-ignited.

3. Turn off the Peltier by choosing Peltier off from the Analyze
menu.

The Vista gas control unit supplies uninterrupted gas purge to the
camera (Vista-PRO only) and polychromator assemblies to minimize
the ingress of moisture. It is strongly recommended that gas supplies
be left on at all times except during long periods of non-use. It is
recommended to turn off the camera Peltier before turning off the
instrument gas supply.

4,  Switch off the mains power switch (the green light will go off).
This will turn off the complete instrument, including the Peltier
{if not done so manually earlier) as well as the polychromator
heater.

5. Loosen the peristaltic pump tubes by releasing the pressure bars
and lift the tubes out of the grooves. To do this:
(a) Unclip and lower the pressure bar screws leaving the pressure
bars resting loosely against the rollers.
(b) Lift the tubing out of the grooves so that they are not being
stretched over the rollers.

6.  Switch off the water cooler, lahoratory exhaust system and any
accessories (where applicable), and shut down the argon gas
supply at the cylinder.

The Vista gas control unit supplies uninterrupted gas purge to the
camera (Vista-PRO only) and polychromator assemblies to minimize
the ingress of meisture. It is strongly recommended that gas supplies
be left on at all times except during long periods of non-use, It is
recommended to turn off the camera Peltier before turning off the
instrument gas supply.
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Exit the ICP Expert software, if it is no longer required, by
choosing Exit from the File menu. Switch off the printer and
monitor,

Restarting the instrument will take several hours due to gas purge
and polychromator thermal stabilization time.
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5. Maintenance

This chapter includes the maintenance requirements for the Vista that
may be carried out by an operator. Any maintenance procedures not
specifically mentioned in this chapter should be carried out only by
Varian-trained, Varian-qualified or Varian-authorized customer
service representatives,

Warning

The piasma is an intense light source. Direct viewing of the light
source will cause eye damage, Operators and other unauthorized
personnel must NEVER remove the main covers or disable the safety
interlock system,

5

Warning

This instrument contains electrical circuits, devices and components
operating at dangerous voltages. Contact with these circuits, devices
and components can result in death, cause serious injury, or painful
electrical shock, :

Warning

The plasma radiates dangerous levels of radio frequency (RF)
energy. Exposure to the RF energy can cause severe skin damage
and cataracts of the eyes, while close contact with the operating
plasma can result in severe heat burns to the skin, and an electrical
discharge which can jump a considerable distance and may cause
death, severe electric shock or sub-surface skin burns.

=3 Note  This section refers only to maintenance procedures for the Vista
instrument. You should refer to your PC and printer manuals for their
maintenance procedures, and to the ICP Expert online Help for the
maintenance procedures for any accessories you ordered.
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5.1

Routine maintenance

The ICP Expert online Help details all the maintenance procedures and
includes instructional video clips. The following parts of the Vista
require routine maintenance and instructions on how to do this are
included in the online Help. To access these instructions, click the
Windows Start button, then Programs » ICP Expert ™ ICP Expert
Help. Click the Maintenance link.

Hourly
O Check and, if necessary, empty the drain vessel.
Daily

0 Check the water level in the Argon Saturator Accessory (ASA)
hefore every use {if applicable).

O Clean the surface of your Vista (spills should be cleaned up
immediately).

O Inspect the pump tubing and replace if it has lost its elasticity.
Unclip the pump tubes when the pump is not in use.

Weekly

(lean the torch.

Clean the cone (axial instruments),
Clean the snout (radial instruments}.
Clean the bonnet (radial instruments),

(lean the spraychamber,

0H 0o 0 0 g8 g

Clean the nehulizer,
Monthly
0O Clean the cooling air intake filter on top of your instrument,

0O Inspect the state of the induction coil, Contact your local Varian
office or representative if maintenance is required.

O Check the water level in the water cooler (refer to manual supplied
with the water cooler for details).

O Perform a wavelength calibration,
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5.3
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Maintenance of consumables

Cleaning

For information on maintaining consumables (such as replacing the
torch, cleaning the cone, replacing the peristaltic pump tubes and
replacing fuses), refer to the online Help. Specifically:

1. Click the Windows Start button and choose Programs » ICP
Expert » ICP Expert Help.

2, When the ICP Expert Help software appears, click the

Maintenance link to view step-by-step instructions on how to
maintain instrument consumables.

Any spills in the sample compartment should be wiped up
immediately.

The exterior sutfaces of the Vista should be kept clean. All cleaning
should be done with a soft cloth. If necessary, this cloth can be
dampened with water or a mild detergent. Do not use organic solvents
or abrasive cleaning agents,

\?c"l
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6. Troubleshooting

Information regarding troubleshooting of the installation of the Vista
GPIB is given here. If you have any other problems with your Vista
instrument you will find troublesheooting information in the online
Help. Click the Windows Start button, then Programs » ICP Expert
» ICP Expert Help. Click the Troubleshooting link.

6.1 Installation troubleshooting
6.1.1 Windows® service or driver failure
Problem

Eewn:a_ Contrel Manager

Solution 1

1. Click the Windows® Start button and choose Programs »
Administrative tools » Event Viewer.
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2, FYind the hardware device driver that failed to load during startup
event (indicated by a red STOP on the left hand side).

Event Yiewer - Egstem L

H 10 (i |

/515 104208 a0 Ewentlog . Hone
& 1/21,45 10421048 Service Contisd MerMNaong
&1/2109 0 104040 Abd Eventiog Mone

3. Double-click on the failed event to determine the cause of the
failed device, If it was the Vista that failed to load you will see the
following description:

4. This generally means that the device driver loaded but there was
no response from the Vista instrument. This indicates that the
Vista interface hardware is not responding.
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5. Ensure that the Vista card is installed correctly and that the
interconnecting cable is secure,

Solution 2

Another cause of this error may be due to a conflict between the Vista
driver and another driver on the system, This is more likely to happen
on a Windows NT® system. The most common cause is a sound card
for which a driver has not been installed. The PC may have a sound
card built into the motherboard as well as a separate sound card which
the PC recognizes but doesn't have a driver installed for.

You will need to:
1. Uninstall the ICP Expert software.

2. Uninstall the Vista driver (refer to section 6.5).

3. (lick Start, Settings, Control Panel, Multimedia (for a Windows
NT® system) or System (for other Windows® operating systems).
Click the Devices tab (Windows NT®) or Device Manager tah (other
Windows® operating systems).

Mullimedia Peapeities
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4, If you see a ! mark next to one of the devices you need to fix the
problem (usually by installing the latest driver) before installing
the ICP Expert software,

6.2 Access denied

Problem

During the installation of the ICP Expert software you may see the
following message:

Solution

You must be logged on with administrator rights to install the ICP
Expert software. Click the Windows® Start button, then Shutdown
and Close all programs and log on as a different user. When
promapted, log on as an administrator or ask your administrator to log
on for you. Start the ICP Expert installation process again,
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6.3 OSIGPIB service failed to start

Problem

After the installation of the ICP Expert software the following message
is displayed:

Solution

This indicates the Vista GPIB device driver was not copied to the
correct directory.

It is possible you may not have access rights to the installation drive.

Log on with administration rights (refer to section 6.2) and perform
the ICP Expert installation again.
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6.4

ICP Expert software failed to start

Problem

When you open the ICP Expert software the following message is
displayed:

E“cep[mn R

Solution

This may indicate that there is a conflict with the Vista GPIB device
driver. The action you take will depend upon which version of the
Windows® operating system you are using.

To rectify this conflict in Windows® 2000 or Windows® XP, try
uninstalling the software then re-install it.

Ta rectify this conflict in Windows NT®, do the following:

1. Click the Windows Start button and then choose Settings »
Control Panel. '

2. In the Control Panel, click the Devices icon.

3. In the Devices dialog box, ensure the following:
O The Varian Simple GPIB driver is set to Disabled.
O The OSIGPIB driver is set to Automatic.
To change the seitings of a driver, do the following:

1. Highlight the driver in the list and select Startup. The
Device dialog box appears.

2. TFrom the Device dialog box, select the appropriate Startup
Type for the driver (e.g., Disabled or Automatic).

3. Click OK to return to the Devices dialog box and Close to
exit.

4. You now need to to restart the computer. To do so, click the
Windows Start button then Shutdown and Restart the
computer. Click OK and wait for the computer to restart.
The Vista driver will be enabled when the computer
restarts.
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6.5 Uninstalling the Vista GPIB drivers for Windows NT®

1. Click the Windows® Start button and choose Settings » Control
Panel.

2. In the Control Panel, click Devices. The Devices dialog box
appears.

Stated. - Beot
“Disabled
- Disabliad
“Dizabled

_Bisabled. |
[iizabled
Aafornatic: 3
Dizatiled
Dizabled
Dizabled

3. Use the scroll bar to locate the OSIGPIB device and highlight it.
4. Click Startup. The Device dialog box is displayed.

5. From the Startup Type list, select Disabled and then click 0K to
return to the Devices dialog box.

6.  Click Close to exit.
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7. You now need to to restart the computer. To do so, click the
Windows® Start button then Shutdown and Restart the
computer. Click OK and wait for the computer to restart. The
Vista driver will be disabled when the computer restarts.
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Accessories, options, spare
parts
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The options, accessories and spare parts that are available for the Vista
are listed in the online Help of the ICP Expert software, To access
these details, click the Windows Start button, and then choose
Programs » ICP Expert » ICP Expert Help. Click Parts and Supplies
from the window that is displayed. Varian's website at
www.varian.com contains a complete list as well, which is regularly
updated.
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